
2007 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

UNOS Creator  
User Manual 
 
 
 
 
       

                     

2010 

publication 

Richard Foss 
UMAN 

2/24/2010 



2 | P a g e  
 

 

 

UNOS Creator ς User Manual 

 

 

Contact details: 

UMAN Universal Media Access Networks GmbH 

Martinstraße 48-50 

40223 Düsseldorf 

Germany 

Tel.: +49 (0) 700 8626 8626 

Fax.: +49 (0) 211 88253 1115 

www.umannet.com 

 
Dipl. Phys. Jürgen Scheuring, CEO ς  j.scheuring@umannet.com 

Robby Gurdan, CTO (Tonnmeister) ς rg@umannet.com 

Richard Foss, VP Engineering (PhD) -  r.foss@umannet.com 

 

 

 

 

 

 

 

 

 

 

 

www.umannet.com


3 | P a g e  
 

Contents 
 

1. Introduction ................................................................................................................................. 4 

2. An overview of the desk item mechanism .................................................................................. 4 

2.1 Desk item extraction ................................................................................................................. 4 

3. Creating a simple Desk Item layout for an evaluation board ...................................................... 6 

3.1 Desk Item construction with UNOS Creator .............................................................................. 8 

3.2 Adding new desk items............................................................................................................ 10 

3.3 Creating a Fader desk item ...................................................................................................... 10 

3.4 Creating a Meter desk item ..................................................................................................... 14 

3.5 Saving the desk items onto the evaluation box ...................................................................... 20 

3.6 Making the new desk items appear in Unos vision ................................................................. 24 

4. Conclusion ................................................................................................................................. 26 

5. References ................................................................................................................................. 26 

 

  



4 | P a g e  
 

1. Introduction 

 

UNOS Creator provides a manufacturer with a Desk Item editing capability. It allows the 

manufacturer to specify images for the various components of desk item controls, indicate the 

relative lay out of these controls, and furthermore specify the device parameters that will be directly 

controllable by the desk item controls. Once specified, the desk item information can be 

encapsulated into an XML file and saved on the device. UNOS Vision is able to access this desk item 

file, display the desk items and hence allow for the control, and monitoring of the device.  

 

2. An overview of the desk item mechanism 

 

As the name implies, Desk Items are control items such as sliders, pan pots, and meters that are 

arranged on a 'desk top'.  Information about the nature of the desk items, their associated graphical 

images, and their layout for a particular device, resides within the device itself. The device will also 

contain information that associates desk items with actual controllable parameters on the device, 

such as gain and equalization parameters, or with parameters that need to be displayed, such as 

temperature and current levels.  

For the remainder of this section, we shall consider the mechanism that allows a controller device 

with a display to: 

 extract desk item information from a target device, 

 display the desk items in a desired layout 

 allow for user control of device parameters via the desk items (eg. gain control) 

 allow for display of device parameter values via the desk items (eg. metering) 
 
 

2.1 Desk item extraction  

 

The process of desk item extraction is shown in Figure 1 below. 
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Each desk item has an XFN parameter associated with it, known as a 'control parameter'. The value 

of this control parameter will be the value of the desk item.  

This association with a control parameter allows for the joining of desk items to other desk items, 

and also to parameters on devices. The capability of joining desk item parameters to other desk item 

parameters allows for interaction between desk items on a display. The capability of joining desk 

item parameters to parameters on remote devices allows for desk item control over these remote 

parameters, known as 'action parameters'.   

 

This association of desk items with control parameters and the joining of the control to action device 

parameters are shown in Figure 2 below. 

 

 

 

 

 

 

 

Desk item info 

Device A 

Desk item info 

Device B 

Desk item info 

Device C 

Device display 

  Control device 

Desk item info request 

Desk item info  

Figure 1 - Obtaining desk item information 
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It is also possible for an action parameter such as a gain, to 'push' its current value to the control 

variable associated with a desk item. Such a capability would be useful if a meter desk item were to 

be used to display the varying values of, for example, a gain parameter. 

 

3. Creating a simple Desk Item layout for an evaluation board 

 

We shall assume that you are currently running UNOS Vision, and have a network comprising one or 

more subnets, each subnet containing one or more devices. The 'Devices' view within UNOS Vision, 

for a small 5 subnet configuration, is shown in Figure 3 below: 

Parameters 

Device A 

Parameters 

Device B 

Parameters 

Device C 

Device display 

Control Device 

Parameters 

Associations 

Joins between 

parameters 

Figure 2 - Joining desk item and remote parameters 
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Figure 3 - Small network configuration 

 

Imagine that we want to create a simple desk item for the UMAN evaluation board with IP address 

192.168.2.3. Double clicking on the evaluation board representation will cause the following screen 

to be displayed. 

 

 

 



8 | P a g e  
 

 

Figure 4 - Viewing the current Evaluation board desk items 

 

On selecting the UMAN evaluation board, the current desk item for the evaluation board is displayed. 

As can be seen in the upper right corner of the display, the current desk item display provides 

controls for a comprehenisive matrix mixer, where each cross point of the mixer allows for level 

control. Assume that we want to provide a far simpler display, with a single fader and meter that will: 

1. Allow for fader (slider) control over the level of the cross point 01->01. 

2. Allow for metering of the audio level as it enters the 01 input. 

3.1 Desk Item construction with UNOS Creator  

 

The first step in this contruction procedure is to access the graphic editing capabilities of UNOS 

Creator. As shown in the screenshot below, this involves accessing the 'Tools' menu, followed by 

selecting the 'GUI Editor' from the pull down menu. 

 

 

 

 

 

 



9 | P a g e  
 

 

Figure 5 - Accessing UNOS Creator 

 

Within UNOS creator, the first step is to create a new desk item page, as shown in the screenshot 

below: 

 

Figure 6 - Creating a new desk item image 
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3.2 Adding new desk items  

 

 From now on, it is possible to successively add new desk items via the 'Add new desk item' submenu 

of the top level 'Edit' menu. This is shown in the screenshot below: 

 

 

Figure 7 - Choosing a desk item 

Upon requesting a particular desk item, an outline of the desk item will be placed within the grey 

rectangle containing grid lines. Note that the orange borders of this rectangle represent the borders 

of your final desk item display.  

As shown in the above screenshot, the first desk item selected will be a Fader desk item. After 

selecting the Fader desk item, the right hand side of the UNOS Creator screen will display a number 

of modifiable parameters relevant to the display and functioning of the Fader desk item.  

 

3.3 Creating a Fader desk item  

 

The first parameters that we shall modify are the various fader desk item skin images: 

 Fader Back Image 

 Fader Track image 

 Fader thumb image 
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 Possible images for a Fader desk item can be found in the \Images folder within the UNOS Vision 

folder that UNOS Vision was extracted to.   

The screenshot below shows the selection of the 'FaderBack' image file, after the 'Load Picture' 

button was pressed. In this case the image incorporates both the fader background and track images. 

 

 

Figure 8 - Loading the Fader image files 

 

Given below is a screenshot after fader image selection is complete. 
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Figure 9 - Complete fader desk item graphics 

 

It may well be that various parameters associated with the fader thumb and track need to be 

modified. In particular, ƛǘ ƛǎ ƛƳǇƻǊǘŀƴǘ ǘƻ ǳƴŘŜǊǎǘŀƴŘ ŀƴŘ ŀŘƧǳǎǘ ǘƘŜ ΰ¢ƘǳƳō bŜŜŘƭŜΨ ǇǊƻǇŜǊǘƛŜǎΣ ǘƘŜ 

thumb needle being the point on the thumb that indicates its current position. 

1. Thumb needle offset ς the offset (in pixels) of the marker on the thumb button relative 
to the top of the thumb button.  

2. Thumb needle range offset ς the offset (in pixels) of the topmost position that the 
marker can  go up to. This is relative to the whole deskitem.  

3. Thumb needle range length ς the length (in pixels) from the topmost position of the 
marker to the bottommost  marker position.  

 

After adjusting the visual parameters associated with a desk item, it is then necessary to associate an 

XFN parameter with the desk item. Before doing this, it would be useful to have an understanding of 

the 7 level hierarchical structure of XFN parameters. This can be acquired from the XFN (X170) 

specification [1]. The screen shot below shows the XFN parameter selection process after the 

'Choose parameter' option has been selection from the 'XFN Parameter Info' section. 
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Figure 10 - Associating a parameter with the desk item 

 

In this screenshot, the subnet 192.168.2.0 has been selected (the subnet where the evaluation box 

resides) and the actual evaluation box (192.168.2.3). A particular parameter has been selected with 

the level hierarchy: 

XFN_PRM_BLOCK_BUS1 

Bus1 In 1 

XFN_PRM_BLOCK_PROPERTY 

Bus2 In 1 

XFN_PTYPE_LEVEL_LEVEL 

1 

 

Note that you need to click on the bottom level of the hierarchy for the parameter to be selected. 

 

This parameter represents the level of a cross point on a matrix, where the inputs to the matrix are 

the bus 1 lines, and the outputs of the matrix are the bus 2 lines. The screenshot below shows the ID 

numbers that have been alllocated to each level of the parameter.  
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Figure 11 - Fader desk item with parameter settings 

 

To determine whether the fader is fully operational and is adjusting the chosen parameter, select the 

'Preview UI' tab on the right of the screen. When the fader thumb is moved within the preview 

mode, UNOS Creator will ensure that the appropriate XFN messages are sent to the UMAN 

evaluation box at its IP address. 

However, in the case of this parameter, you need to be sure that audio is routed to the appropriate 

Bus 1 line from an input, and that audio is routed from the appropriate Bus 2 line to an output. This 

can be done within UNOS Vision, and the procedure is described within the UNOS Vision manual [2]. 

 

3.4 Creating a Meter desk item  

 

We can now move on to creating a meter desk item that will meter the changing audio levels on the 

first bus line of the mixer matrix within the evaluation box. As with the fader, the first step is to select 

the appropriate desk item. 

This step is shown in the screenshot below. 
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Figure 12 - Meter desk item selection 

After selecting a 'Skinnable Peak Level Meter' as the next desk item, an appropriate meter 

background image can be selected from the /images folder, as shown below. 

 

 

Figure 13 - Meter desk item images 
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A meter desk item is somewhat more difficult to deal with than a fader desk item since it requires the 

creation of a meter 'stripe' image for each meter value.  A graphical editing program such as 

PhotoShop must be used to create a series of meter stripes, each stripe being a fixed number of 

pixels in length, and each stripe being of such a size that it can be overlaid onto the meter 

background. A portion of such a stripe is shown below. 

 

 

 

Figure 14 - Creation of a 'meter stripe' 

 

This meter stripe image can be loaded from the /images folder. 

The final meter image to be loaded is the peak meter strip image. The peak meter stripe image is 

used to give the user an indication of the peak value within a certain time interval. Just as for the 

meter stripe, a graphical editing program must be used to create a series of peak meter stripes, each 

stripe being the same fixed number of pixels in length. However, each peak meter stripe will consist 

of just a single band. 

The selection of a peak meter stripe image is shown in the screenshot below. 
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Figure 15 - Selecting the 'Peak level meter stripe' 

 

Note ς the group of 'SpeakLevelmeter' parameters ƎƛǾŜǎ ǘƘŜ ǇƻǎƛǘƛƻƴƛƴƎ ƻŦ ǘƘŜ [95Ωǎ, while the  

'Deskitem placement' group of parameters gives the size and positioning of the entire meter, 

background included. 

As for the Fader desk item, the meter desk item has to be associated with a particular parameter. 

However, in the case of the meter desk item, the parameter values will be 'pushed' to the meter at 

regular intervals.  
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Figure 16 - Selecting the metering parameter 

 

In the above screenshot, the subnet 192.168.2.0, and the device IP of the evaluation box, 

192.168.2.3, have once again been selected. Furthermore a particular parameter within the 

evaluation box has been selected for metering. The address hierarchy for this parameter is: 

 

XFN_PRM_BLOCK_BUS1 

XFN_SCT_TYPE_AUDIO 

Bus1 In 1 

XFN_PRM_BLOCK_PROPERTY 

1 

XFN_PTYPE_MATRIX_PEAKMETER 

1 

 

After selecting the parameter and closing the dialogueΣ ǘƘŜ L5Ωǎ ƻŦ ǘƘŜ ǾŀǊƛƻǳǎ ƭŜǾŜƭǎ ǿƛƭƭ ōŜ ŘƛǎǇƭŀȅŜŘ 

as XFN parameter info. This is shown in the screenshot below. 
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Figure 17 - Meter desk item with parameter data assigned 

 

The working of the meter desk item can be tested by selecting the 'Preview UI' tab on the right hand 

side of the display. If UNOS Vision has been used to route audio to Bus1, In 1, then the meter should 

be responsive. A screenshot of this is shown below. 

 

 

Figure 18 - A preview of the fader and meter desk items 
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3.5 Saving the desk items onto the evaluation box  

 

This fader/meter desk item combination should now be saved. UNOS Creator will save your 

deskitems as an XML file, where the XML file contains the desk item information that you have 

provided (images, placement, associated parameters, etc.). Before you save your desk items, you 

should ensure that the page on which you created your desk items is specified to be page number 1. 

To do this, click the 'Page' tab on the right hand side of the screen, and then set the page number to 

1 as shown in the screenshot below. 

 

 

Figure 19 - Setting the desk items page number 

 

You can now save your desk items to any suitable folder, giving the file an appropriate name. This is 

shown in the screenshot below. After saving the desk item file, you can later load it and modify it to 

incorporate additional desk items, for example. 
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Figure 20 - Saving the desk item page 

In order for your desk items to be loaded from a device, they have to be packaged into a compressed 

(.zip) format, and uploaded to the device. The first step is to package the desk items, and this 

capability can be accessed from the 'File' menu. 

 

 

Figure 21 - Packaging the desk items 
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After the packaging operation is complete, you should upload the package to the device. This can be 

done by moving to UNOS Vision, and then selecting the 'Tools -> UMAN Audio Node Firmware 

Loader' menu option, as shown in the screenshot below. 

 

 

Figure 22 - Accessing the desk item loader 

 

Your first task is to select the device to upload to. This requires selecting the subnet where the device 

resides, and then the device itself. 

The firmware loader provides you with the option to either upload a firmware or desk item image.  

You should choose the desk item option, and then click the 'File...' button to specifiy your desk item 

file.  After choosing your packaged desk item file, you should click the 'Upload' button to upload the 

file to your device. 

The complete upload process is shown in the two screenshots below.  
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Figure 24 - The desk item package uploaded 

 

Figure 23 - Selecting the packaged desk items 
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3.6 Making the new desk items appear in Unos vision  

 

At this point, you should exit UNOS Vision and power cycle the device with the updated desk items. 

Next, you should view the folder into which you extracted the UNOS vision package. This folder 

contains a number of sub-folders. Go to the 'DeskItems' folder. Within that folder are a number of 

subnet folders, each labelled with their subnet IP addresses. Choose the appropriate subnet folder, in 

our case 192.168.2.0. Within the subnet folder are a number of device folders, each labelled with the 

IP address of the device, in the case of our evaluation box ς 192.168.2.3. 

At start up, when UNOS vision enumerates the network, it builds these subnet and device folders for 

ǘƘŜ ŜƴǘƛǊŜ ƴŜǘǿƻǊƪΣ ƛŦ ǘƘŜȅ ŘƻƴΩǘ ŀƭready exist. If the program finds a device without an associated 

ŦƻƭŘŜǊΣ ƛǘ ǿƛƭƭ ŎǊŜŀǘŜ ŀ ŦƻƭŘŜǊ ŦƻǊ ǘƘŜ ŘŜǾƛŎŜΣ ŀƴŘ ǿƛƭƭ ŘƻǿƴƭƻŀŘ ǘƘŜ ŘŜǾƛŎŜΩǎ ŘŜǎƪ ƛǘŜƳ ·a[ ŦƛƭŜ ƛƴǘƻ ŀ 

\xml folder within this device folder.  This will prevent UNOS vision from having to download the 

desk item file every time it enumerates the network. 

You need UNOS Vision to not find a device folder for the evaluation box, and to subsequently 

download the new desk item file. As a first step, re-ƭŀōŜƭ ǘƘŜ ŘŜǾƛŎŜΩǎ ŦƻƭŘŜǊΣ ŀǎ ǎƘƻǿƴ ƛƴ ǘƘŜ 

screenshot below. 

 

 

Figure 25 - Re-labelling the device folder 

 

Following this, you should restart UNOS Vision, and from the Options menu ensure that the default 

desk item file is not use for the display of the evaluation box desk items. This selection is shown in 

the screenshot below. 
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Figure 26 - Disabling use of default desk item folder 

 

Upon selecting the appropriate subnet, and then choosing the evaluation box from the Devices 

matrix, the uploaded desk item file will be downloaded from the device. Have a look at the status bar 

of the screenshot below. 

 

Figure 27 - Downloading desk items from device 
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Once loaded, the desk items (fader and meter) will apear in the device-specific control window, and 

you should be able to effect parameter value changes and see the meter responding  if you have 

made the appropriate matrix connections. This is shown in the screenshot below. 

 

Figure 28 - The fader/meter desk items displayed and usable 

 

4. Conclusion 

 

The desk item capability is based on a simple, but powerful concept, namely that the graphic 

controller obtains its desk item information from the device itself. This relieves the controller of 

holding and updating desk item display and parameter association information for a large range of 

devices from various manufacturers. It places the display of graphic controls in the hands of the 

manufacturer. 

This user manual has introduced the desk item concept and the construction process via a simple 

tutorial example. This should have laid the foundation for the construction of other desk items. If 

there are questions regarding this construction process, plesae contact UMAN. 
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